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Manufacturer:   Cambridge Sensotec Ltd. 

Unit 29 Stephenson Road 
St Ives 
Cambs 
PE27 3WJ 
 

Product Names:   Rapidox portable oxygen gas analyser 
 
Model Numbers:   RX1100ZR 
 
Conform to the following specifications: 
 
EMC:  EN 61326:1998 Electrical equipment for measurement,  
     control and laboratory use 
 

Declaration: I declare that the above products conform to the applicable 
requirements of the LVD Directive 73/23/EEC and the EMC Directive 89/336/EEC 
and is CE marked accordingly. 
 

Signature:     
 
Name:    Dr. Mark Swetnam 
 
Title:     Managing Director 
 
Company:    Cambridge Sensotec Limited 
 
Date:     4th May 2009 

 
WEEE Regulations 2006 

 
Cambridge Sensotec takes its responsibilities under the WEEE 
Regulations extremely seriously and has taken steps to be compliant in 
line with our corporate and social responsibilities.   In the UK, 
Cambridge Sensotec has joined a registered compliance scheme 
“WeeeCare” (WeeeCare registration number WEE/MP3538PZ/SCH). 

 
UK users only:  If you have purchased any electronic or electrical product from 
Cambridge Sensotec since 2007 and would like to dispose of it correctly under the 
WEEE scheme, please contact us and we will be happy to either arrange the 
collection of the waste or have it returned to our offices for recycling.  All our in-
house manufactured products are scheme compliant and carry the WEEE label 
indicating that it is NOT allowed to be disposed of in a landfill site. 
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1. Introduction 

 
The Rapidox 1100ZR oxygen analyser allows fast and accurate oxygen analysis 
over the oxygen range 1ppm to 100% O2.  The analyser provides continuous on-
line oxygen analysis, with a typical response time of less than 4 seconds for a 90% 
response to a step change in gas compositions. 
 
The Rapidox 1100ZR is a fully integral unit complete with a powerful diaphragm 
pump to provide variable gas sampling up to approximately 1.2 litres per minute.  
 
The sensor head is located inside the analyser and comprises a zirconia ceramic 
tube that needs to be heated to 650°C before it will conduct oxygen ions.  The 
analyser supplies heat to the sensor, which is controlled very accurately by a 
regulated power supply incorporated in the instrument.  An internally mounted 
pressure sensor compensates for any fluctuations in pressure or vacuum caused 
by differing flow conditions. 
 
The analyser is packed with features including programmable alarm circuits, 
programmable analogue outputs, easy calibration (user selectable gases), RS232 
communications and complete communications / data-logging software. 

2. Features 
 
 Very fast measurement response (typically 4 seconds for a 90% response). 

 
 Wide measurement range available (1ppm to 100% O2). 

 
 Accuracy ± 1% of the actual measured oxygen with a precision of ± 0.5%. 

 
 Easy calibration procedure requiring any two or three gas mixtures (ordinary 

room air is usually one). 
 

 Low maintenance, sensor life expectancy typically 17,500 hours 
 

 Powerful variable speed diaphragm pump fitted for sampling the gas 
 

 Large back-lit LCD display (16 x 2 characters). 
 

 RS232, 0-10V and 4-20mA current loop outputs (both fully programmable). 
 

 Fully programmable alarm circuits. 
 

 Full data-logging software accessed via RS232 connection to a PC (RS485 
available on request). 
 

 PIN code protection available 
 

 Optional printer attachment 
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3. Specification 
 

3.1 Dimensions & Power Requirements 

 

Case dimensions: W=250mm; D=263mm; H=150mm.  Weight=3.5kg.  Metal 
carrying handle supplied as an option.  Runs on ANY Worldwide voltage 90-
260VAC 50/60Hz. 
 

3.2 Accuracy and Precision 

  
Sensor response time is typically 4 seconds for a 90% response involving a step 
change in composition.  High accuracy is maintained between calibration points.  
Accuracy is 1% of the actual measured oxygen content with a precision 0.5%.  
Outside the calibration range accuracy is typically 2.5%. 
 

3.3 Display 

 
The analyser has a 2-line 16x2, 9mm character, back-lit liquid crystal display 
(LCD), whose data update rate is user-programmable.  The LCD displays four 
significant figures of oxygen (O2).  The display notation (percent, ppm, 
exponential or ‘automatic’) is user selectable. 
 

3.4 Calibration 

 
The simple and fully flexible calibration procedure requires two or three 
calibration gases (ambient air 20.95% is normally used as calibration gas ”HIGH”).  
The calibration gas compositions are user-selectable and programmed into the 
Rapidox via the keypad menu or the RS232 link and configuration software.  
Factory pre-sets can be reloaded to allow the unit to be 'rescued' from a failed 
calibration.  The Rapidox is calibrated using the keypad on the front panel or 
directly with the software provided.  The LCD changes to calibrate mode to inform 
the user of progress. 
 

3.5 Operating Temperature 

 
Gas inlet temperature must not exceed 60oC.  The Rapidox unit’s normal operating 
temperature is 5-35oC. 
 

3.6 Outputs 

 
The RS232 serial port (RS485 is available on request) outputs on demand values 
for oxygen (ppm) , the internal pressure sensor data (pressure in bar), time 
(hh:mm:ss) and date (dd/mm/yy).  This data can be downloaded and logged using 
the software provided. 
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Standard 0-10V and 4-20mA analogue outputs are available on the rear panel for 
both O2 and pressure, as are 10V (logic level) normally-open or normally closed 
reed relay alarm signals (assignable to any gas).  These outputs are fully user-
programmable via the front keypad or RS232 link and the supplied configuration 
software using the RS232 link. 
 

4. Technical Specification 

 

Property Specification 
Supply Voltage 90-260VAC, 50/60Hz 
Power consumption 100W (max) 
Analyser dimensions 250mm X 263mm X 150mm 
Weight 3.5 kg 
Display 16  2 character (9mm) back lit LCD 
Warm up time 3-4 minutes at 20°C 
Normal operating temperature 5-35°C 
Sensor Range 1ppm to 100% O2 

Sensor Accuracy 
1% of the actual measured oxygen 
content with a precision 0.5% 

Outputs: O2 & pressure 
0-10V (user-programmable) into minimum 
5k 

  O2 & pressure 
4-20mA current loop (user-programmable) 
into maximum 500 

  O2 high and low alarms Relay circuits – fully user-programmable 

  All data and parameters 
RS232 or RS485 - data streamed on 
demand 

Sample Pump 
Mains type diaphragm vacuum pump 
(variable flow) with power switch on rear 
panel. 

Flow Rate 0-1.2 L.min-1  
Max. gas temperature on input 60°C 

Calibration 

Requires 2 or 3 user-selectable gas 
compositions (air is default plus another 
two) 

5. Precautions 
 
Make sure you read and understand these instructions and keep them safe for later 
use.  The unit should not be exposed to extreme temperatures < -5°C or > 60°C.  
Normal operating temperature is 5-35°C.  Avoid direct sunlight.  Do not use liquid 
cleaners, aerosols or solvents to clean the case.  Use a damp cloth for cleaning.  Do 
not use this equipment near water.  Avoid touching the LCD display as this may 
cause permanent damage.  Make sure the rear ventilation slots and the fan on the 
rear panel are free of obstruction. 
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There are no user serviceable parts in this unit.  Do not attempt to repair yourself.  
Refer all servicing to qualified Cambridge Sensotec personnel. 

6. Warning 
 
This unit is NOT designed for use in life support situations.  No responsibility can 
be held for injury or loss of life caused by inappropriate use of this equipment. 
 

7. Rapidox Operating Instructions 
 
 

 

Figure 1: Rapidox 1100ZR front panel.  Numbers are referred to in the text. 

1 
2 

5 
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Figure 2: Rapidox 1100ZR rear panel.  Numbers are referred to in the text. 

 

7.1 The Rapidox Analyser - Menu System 

 

All of the user-programmable functions are accessed via a menu system which is 
controlled using the front panel Keypad (2).  To access the menu press the ENT 
button and to escape and return to the operating screen press ESC at any time.  
The menu system flow chart is shown below: 
 

7.2 Getting Started 

 

Ensure that the Rapidox analyser is located away from extreme heat and dirt 
environments.  Plug the unit in to a suitable supply (noting the information on the 
serial sticker and using the power cable supplied) using the rear power socket (8).  
Make sure that the cooling fan (9) is not obstructed during operation.   
 
Push the gas sample tube (6mm OD/4mm ID) to the GAS IN (3) connector and fit 
the retaining collar hand tight.  Repeat for the GAS OUT (4) connector should an 
outlet tube be required.  The pump will draw gas at a flow rate depending on the 
value set either in the software or from the menu.  The default setting is one 
hundred percent. 
 
Turn the unit on using the red power switch on the front (5).  The LCD (1) will 
display the firmware version followed by the message “HEATING SENSOR”.  The 
sensor will take approximately four minutes to come up to temperature, after 
which the Rapidox will begin to take measurements.  The progress of the sensor 
heater is shown in the form of a bar graph on the LCD (1).  Once at temperature 
the LCD display will show the oxygen reading and the pressure.  The symbol AL1 
or AL2 may appear to the bottom right of the LCD if the alarm system is enabled 

3 4 

6 
7 

8 9 
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and an alarm condition applies. 
 
Allow thirty minutes for the box to stabilise fully.  This allows the components of 
the analyser to reach a stable working temperature.  During this warm-up period it 
is common for the baseline oxygen to drift by a small amount, which may be 
corrected by re-calibrating (see section 7.5). 
 

7.3 Pump Control 

 

The flow rate of gas drawn into the analyser can be controlled using the menu 
option 9: “Set Pump Flow”.  The unit is supplied with the flow rate set to 100% 
which equates to approximately 1.2 Litres per minute.  If you wish to change the 
flow rate press ENT and select menu option 10.  Use the UP & DOWN arrows to 
change the value from OFF – 100% in steps of 10% increments.  Alternatively the 
pump can be switched on or off using the switch (10) on the rear panel.  Please 
make sure that this is switched on and the pump is running.  When using the unit 
with a pressurised (flowing) gas source the pump can be left switched off. 
 

7.4 Menu Access / Passwords 

 

The analyser has an option to set a password that will restrict access to the menus.  
The password menu is disabled by default in the factory.  If you wish to password 
protect the analyser press ENT and scroll down to the PASSWORD option (Menu 
option 11).  Pressing ENT again will ask you for the default password which is 
“0000”.  Enter this using the UP and DOWN arrows.  Once the password has been 
entered successfully you can chose between ENABLE and DISABLE in the menu 
using the UP and DOWN keys. 
 
The other option is to RESET the password to a new value.  The password must be 
4 digits long and can be any combination of numbers from 0-9.  Make sure that the 
new password is noted down! 
 
If the password function has been enabled then in the future each time the menu 
system is accessed then the password prompt will display.  After the correct 
password is entered then the full menu will be accessible.  You can make as many 
changes as you want to the options and only press ESC once you have finished.  
Pressing ESC takes you out of the password protected area and you will have to re-
enter the password to go back in again. 
 
If the password has been forgotten please contact Cambridge Sensotec who will 
advise you on how to recover it. 
 

7.5 Rapidox Calibration 

 
Once the unit is at temperature it may be necessary to calibrate the sensor.  Full 
calibration is a simple procedure requiring only two or three gases (one of which 
is normally air – 20.95%).  The two gas values are user-selectable and can be 
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changed by using the front keypad (2) or the communications software described 
in section 8, and the calibration values can be stored on file for later use. 
 
Care must be taken to calibrate the analyser so that, whenever possible, the range 
of measurement lies between the two calibration point extremes.  For example, if 
you are working at 10ppm but have calibrated the analyser between 21% and 
100% then the analyser will be inaccurate.  You would need to calibrate at, say, 
1ppm and 21% to be sure of good accuracy.  The procedure is as follows: 
 
1) Bearing in mind the points made above, decide which two (or three) gases 

you are going to use for calibration.  If you are constantly working at a 
particular range of compositions then it would be wise to obtain small 
cylinders of calibration gas with analysis certificates.  Cambridge Sensotec 
can supply these.  Press the ENT button on the front panel keypad (2) to 
access the menu system.  The calibration function is option 1 on the menu 
list, which can be scrolled using the UP and DOWN arrows.  Press ENT 
again to enter the calibration menu.  Use the UP and DOWN arrows to 
select O2 HIGH, O2 MIDDLE or O2 LOW and press ENT to proceed.  The top 
line of the display shows the current calibration gas stored and the bottom 
line of the display shows the prompts.  If the gas value is not what you 
require you can edit the value (in ppm scientific notation) using the up and 
down and right arrows on the keypad.  The cursor flashes underneath the 
digit to edit. For example air (20.95%) should be entered as 2.095E+05ppm 
(209,500ppm).  Note that you can not go backwards to edit a digit to the left 
of the cursor.  Instead keep pressing the RIGHT button and the cursor will 
wrap around back to the beginning.  Alternatively press ESC to start again.  
Press ENT when you are ready to proceed. 
 

2) The sensor needs to be exposed to the first calibration gas from a cylinder 
(or exposed to ambient air, 20.95% if this is the calibration gas of choice).  
Allow several minutes to pass to flush the sensor properly.  Wait for the top 
line of the display (1) to become stable.  To complete the calibration press 
and hold the ENT button for two seconds.  During this time you will see a 
bar graph progress across the lower display.  The analyser will then 
recalibrate and display “O2 recalibrated” and then return to normal run 
mode.  The display will now correctly read the value of the first calibration 
gas.  Note that if the ENT button is released before two seconds have 
elapsed, the recalibration will be aborted and when the analyser eventually 
returns to run mode it will use the existing calibration. 
 

3) Note that the analyser should ideally be calibrated at normal ambient 
pressure.  If the pressure correction mode is set to AUTO then it is still 
possible to perform an accurate calibration at pressures other than ambient.  
However above 25mbar (gauge) or below -25mbar (gauge) the display will 
flash and “P?” will display to warn you that the pressure is either above or 
below the range recommended for accurate calibration. 
 

4) The analyser predicts the correct signal from the sensor during calibration 
and if this is outside the range of expected values then the display will flash 
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and display “G?” to warn you that either the cal gas flowing over the sensor 
is different to the value you have programmed OR the sensor may be old 
and approaching the end of its life.  Check before proceeding! 
 

5) To calibrate against the second or third calibration gas, repeat the 
procedure from 2 but this time press ENT followed by the UP or DOWN 
button to scroll through to the “O2 Middle” or “O2 Low” screen.  Flush the 
sensor chamber with the second calibration gas allowing several minutes 
for the new gas to flush through.  Wait for the display to become stable 
before pressing the ENT button for two seconds.  The analyser will then 
recalibrate and display “O2 recalibrated” and then return to normal run 
mode.  The display will now correctly read the value of the calibration gas. 
 

6) The analyser is now correctly calibrated and will read accurately between 
these two calibration points.  Note that this procedure can be performed 
remotely using the software described in section 8.  You can now repeat 
this process for the third calibration gas if required. 
 

7) If at any time, you encounter difficulties and wish to restore the machine to 
its factory set calibration, use the configuration software provided and load 
the default settings (described in section 7.16 below).  Each machine is 
provided with a unique file that contains the factory settings.  This is 
located on the CD-ROM provided and is copied onto your PC during the 
installation process. 
 

8) Note that the three calibration points are independent of each other so you 
can calibrate the analyser in any order you desire.  However please note 
that O2 HIGH must always be greater than O2 MIDDLE which must always 
be greater than O2 LOW.  Typically the factory settings are: O2 
HIGH=20.95%, O2 MIDDLE=0.1% (1000ppm) and O2 LOW=0.001% 
(10ppm). 

 
NB You must always perform a FULL calibration to achieve good accuracy.   

 

7.6 Cleaning the Sensor 

 

You can clean the sensor at any time by pressing ENT on the keypad (2) and 
scrolling down to option 2 “Clean Sensor” or using the software described in 
section 8.6.  Press the ENT button to proceed.  The screen displays “Clean 
Sensor?”.  Press ENT again and the cleaning will take place.  The procedure takes 
approximately five seconds and the LCD display shows the progress of the 
operation.  Once finished the analyser will take a moment to re-stabilise.  The 
sensor is cleaned each time the unit is switched on prior to operation.  If you are 
operating in gases with large amounts of soot, there is a risk that the sensor 
surfaces will become contaminated with particulates, which will impair 
performance if allowed to build up.  The cleaning operation pumps oxygen 
through the zirconia tube, which burns the particulates away from the sensor 
surface. 



Cambridge Sensotec Rapidox 1100ZR Oxygen Analyser Instruction Manual 
 

 

 

 
Version 3.7 9 Last printed 17/11/2011 10:46:00 
 

 

7.7 Alarms 

 

The Rapidox is fitted with two independent and fully programmable alarm relay 
outputs, which can be programmed to be either normally open (N/O) (closes on 
alarm) or normally closed (N/C) (opens on alarm).  You have the option of 
assigning each alarm to the oxygen, pressure (internal) or temperature sensors, as 
well as enabling the alarm relay circuits, enabling an audible buzzer and enabling 
a visual warning on the screen. 
 
The alarms can be programmed by the user via the keypad (2) on the front panel 
or using the software provided (section 8.5.3 ).  To change the alarm settings scroll 
down the menu to no. 3 “Set Alarms” and press ENT.  Now use the UP & DOWN 
arrows to select “Alarm 1” or “Alarm 2” and press ENT.  The next screen shows 
the message “Assign To:”.  Use the UP and DOWN arrows to select O2, or Pressure 
depending on which measurement you want the alarm to work with, and press 
ENT to proceed.  The default is O2.  
 
The next settings configure the behaviour of the alarm.  Use the UP & DOWN 
arrows to select ON or OFF for the following parameters: 
 

1. OUTPUTS:  This enables the rear panel relay outputs when ON is selected 
 

2. AUDIBLE:  This enables or disables the audible buzzer inside the unit 
which will sound in an alarm condition 
 

3. VISIBLE:  This enables or disables warning messages on the LCD screen on 
the front of the Rapidox.  During an alarm condition either “AL1” or “AL2” 
(or a combination of both) will flash at the bottom right hand corner of the 
display. 
 

4. POLARITY: This determines whether you are setting a rising or falling 
alarm.  Use the arrows to change the direction of the alarm to up or down.  
A rising alarm means that the alarm will be silent at values below the set-
point but as soon as the value rises above the set-point the alarm will be 
triggered 
 

5. SETPOINT: The current alarm set-point is displayed in scientific notation 
with a flashing cursor under the first digit.  Use the UP & DOWN arrows to 
change the digit and the RIGHT arrow to progress until the correct value is 
displayed.  When done, press ENT to proceed to the next setting. 
 

6. CONTACTS: The relay outputs can be set to either normally open (N/O) or 
normally closed (N/C).  The factory default is N/O, meaning the contacts 
will close when an alarm condition occurs.  Press ENT to save all the above 
settings for the selected alarm. 

 
Alarm 2 can be set in exactly the same way as described above and both alarm 
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circuits are completely independent of each other.  Note that you must programme 
all the parameters for each alarm for the settings to be saved.  The bottom line of 
the LCD will display “Alarm x set” (where ‘x’ is the selected alarm channel) to 
confirm that the settings have been saved. 
 
The alarm circuit relays are accessed via the terminal block on the rear panel and 
are clearly labelled.  Alarm 1 is assigned to the terminals labelled “Alarm High” 
and Alarm 2 is assigned to the terminals labelled “Alarm Low”.  The relay circuit 
is rated at 24V 0.5amps maximum. 
 
The alarm limits for oxygen are set to a minimum of 10-20ppm and a maximum of 
1000%.  At any time, should a sensor become disconnected so there is a fault 
condition then the Rapidox will set the alarm channel to OFF to prevent false 
alarms, and the relay contacts for the affected channel will go to the programmed 
N/O or N/C setting. 
 

7.8 Analogue Outputs 

 
The Rapidox analyser provides various analogue outputs.  The standard industrial 
analogue outputs (0-10V and 4-20mA) for both oxygen, and temperature (or 
internal pressure) are accessible via the terminal block (6) on the rear panel.  
These outputs have a 12 bit resolution (approximately 1 in 4000) and the lower 
and upper values are fully user-programmable using the keypad (2) or the software 
provided (section 8). In the case of oxygen, three output mode options are 
provided for setting the outputs, in order to give the user maximum flexibility: 
 

1. LIN (ppm):  The linear oxygen output mode setting produces an output that is 
scaled linearly between 0 and 10V (or 4 and 20mA).  So, for example, if the 
scale is set 0V = 0% O2 and 10V = 100% O2 then 5V would indicate an oxygen 
reading of 50% O2.  The scaling of this example is shown in the following plot, 
from which other intermediate values can also be read.  This setting is more 
suitable for medium to high ranges of oxygen, or where the user wishes to 
monitor oxygen over a narrow range. 
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Figure 3: Graph showing the linear output mode option for oxygen 

The following general formulae can be used to calculate the oxygen from the 
voltage or current outputs when set to the linear output mode: 
 

Output type Formula for calculating oxygen from analogue output signal 

0-10V O2 = Vout / 10 * (O2H - O2L) + O2L 

4-20mA O2 = (mAout – 4) / 16 * (O2H - O2L) + O2L 

 
Where:  O2L = user setting of oxygen for 0V or 4mA output 1 

O2H = user setting of oxygen for 10V or 20mA output 1 
Vout = the measured voltage output in volts 
mAout = the measured current output in mA 

1 O2, O2L and O2H must all be in the same units. 

 
2. LOG (ppm):  This setting produces an output that is scaled logarithmically 

between 0V and 10V (or 4 and 20mA).  So, for example, if the scale is set to 0V 
= 0.0001% (1 ppm) and 10V = 100% (1000000 ppm) then 5V would indicate 
an oxygen reading of 0.1% (1000 ppm).  This scale is more suitable for large 
ranges of oxygen down to very low ppm levels.  Note that because the scaling 

is logarithmic 0V cannot be set to 0% oxygen since log(0) is -∞!  The lowest 
permitted setting is 0V = 10-20 ppm (or 10-24 %) O2.  The scaling of this example 
is shown in the blue line in following plot, from which other intermediate 
values can also be read.  For comparison, the red line shows the limitations of 
using the linear oxygen output mode over the same range. 
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Figure 4: Graph showing the logarithmic output mode option for oxygen (blue) compared with 
linear mode (red). 

 
The following general formulae can be used to calculate the oxygen from the 
voltage or current outputs when set to the log output mode: 
 

Output type Formula for calculating log10(O2) from analogue output signal 

0-10V log10(O2) = Vout / 10 * log10(O2H / O2L) + log10(O2L) 

4-20mA log10(O2) = (mAout – 4) / 16 * log10(O2H / O2L) + log10(O2L) 
 
Where:  O2L = user setting of oxygen for 0V or 4mA output 2 

O2H = user setting of oxygen for 10V or 20mA output 2 
Vout = the measured voltage output in volts 
mAout = the measured current output in mA 

2 O2, O2L and O2H must all be in the same units. 

Note: O2 = 10 log(O2) 

 
3. RAW (mV):  This setting is for certain customers who like to monitor the raw 

sensor EMF signal.  The signal from a sensor goes from approximately -50mV 
at 100% O2 through zero at approx 5% O2 and to +1000mV at extremely low O2 
levels.  So, for example, if the scale is set to 0V (output) = -50mV (sensor 
voltage at approximately 100% O2) and 10V (output) = 250mV (sensor voltage 
at approximately 1ppm O2) then 5V would indicate a sensor voltage of 100mV.  
The scaling of this example is shown in the following plot, from which other 
intermediate values can also be read. 
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Figure 5: Graph showing the raw sensor mV output mode option for oxygen 

 
The following general formulae can be used to calculate the oxygen sensor raw 
voltage (O2mV) from the voltage or current outputs when set to the raw sensor 
voltage output mode: 
 

Output type Formula for calculating sensor mV from analogue output signal 

0-10V O2mV = Vout / 10 * (O2mVH - O2mVL) + O2mVL 

4-20mA O2mV = (mAout – 4) / 16 * (O2mVH - O2mVL) + O2mVL 
 
Where:  O2mVL = user setting of oxygen mV for 0V or 4mA output  

O2mVH = user setting of oxygen mV for 10V or 20mA output  
Vout = the measured voltage output in volts 
mAout = the measured current output in mA 

 
The auxiliary outputs can be set to Temperature or Pressure.  The first option will 
output the value read from the thermocouple when attached.  The second option 
will output the value read from the internal pressure sensor. 
 
To modify the oxygen analogue output range scroll down the menu to option 5 
“Set Outputs” and press ENT.  Use the UP & DOWN arrows to select the output 
type either “lin(ppm)”, “log(ppm)” or “raw(mV)” and press ENT.  You can now edit 
the lower and upper values using the UP & DOWN and RIGHT arrows.  Once 
programmed the new values remain in the memory until they are edited again in 
the future. 
 
To select and modify the auxiliary outputs scroll down to menu option 5 “Set 
Outputs” and pres ENT four times.  Use the up and down arrow buttons to choose 
between “Temperature” or “Pressure” and press ENT.  If “Temperature” is selected 
then you can change the low and high range using the same procedure described 
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above.  The range is set between 0°C and 1250°C.  If “Pressure” is selected then the 
permissible range is -1000mbar to +2000mbar. 
 
Note that if the auxiliary output is assigned to temperature and the temperature 
units are set to “None” then the outputs will be set to 0V and 0mA. 
 
Note that the voltage (0 to 10V) and current (4 to 20mA) outputs are locked 
together, so that these outputs cannot be set independently of each other.  In 
normal operation therefore, 0V output always corresponds to 4mA and 10V 
always corresponds to 20mA output. 
 
During initial warm up of the Rapidox when the display reads “Sensor Heating” 
the output sent to the rear terminal for oxygen will stay at 2mA (0.628V) which is 
the standby signal.  The output for the temperature or pressure sensor will begin 
to work after the initial boot up screen. 
 
If at any stage a sensor becomes disconnected (externally or internally) or the 
signal exceeds the measurable range for that sensor, then the display will indicate 
there is a fault and the outputs will change to 1mA (0.313V) which is the sensor 
fault signal.  This will recover as soon as the sensor is reconnected and the fault 
cleared. 
 

7.9 Setting the Display Units 

 
The notation used by the display is fully programmable to suit your needs using 
the keypad (2) or the software provided (section 0).  The following options are 
available to you: 
 

1. Oxygen:  The oxygen reading can be displayed in percent (e.g. 20.95%), 
ppm (e.g. 0.01ppm) or scientific (e.g. 2.095E+05ppm).  If percent is selected 
the Rapidox will display oxygen as a percentage down to 0.1% and ppm 
below this value.  There are also options to display the oxygen reading in 
terms of a pressure (units will be the same as the units selected for 
pressure) or a nitrogen balance (%N2) reading.  In this case the reading 
displayed is 100-O2% =N2 so for example in air 21% the nitrogen balance 
reading will display 79% N2.  Note that this is NOT an actual nitrogen 
reading. 
 

2. Pressure: The reading can be displayed in mbar, bar, psi, torr or kPa. 
 
To program these options scroll down to menu no. 5 “Set Units” and press ENT.  
Use the ENT key to progress through the list and the UP & DOWN keys to select 
the required units.  Once selected press ENT to store and return to run mode. 
 

7.10 Setting the Display Options 

 

The user can select the LCD refresh rate and the format of the line 2 display using 
the keypad or the software provided.  Scroll down the menu to option no. 6 “Set 
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up Display” and press ENT.  Use the UP & DOWN arrows to select either the LCD 
refresh rate or Line 2 Options: 
 

1. LCD Refresh Interval:  The frequency of the display update can be selected 
from 0.1 to 1.5 seconds.  The current setting can be edited using the same 
method as described previously.  Once edited press ENT to store and return 
to the main menu.  The default setting is 0.3 seconds. 
 

2. Line 2 Options:  The information displayed on line 2 of the LCD can be 
chosen by the user.  The options are  None or Pressure (displayed in mbar, 
bar, psi, torr or KPa.  Use the UP & DOWN arrows to select the required 
option and press ENT to store and return to the main menu. 

 

7.11 Internal Pressure Sensor 

 

The Rapidox 1100ZR is fitted with an internal pressure sensor which monitors 
small changes in pressure inside the sensor head.  The pressure will normally be 
zero mbar under normal operation but if the unit is being fed by a gas cylinder or 
connected to an apparatus under partial vacuum then the pressure will change 
and this will have a direct effect on the oxygen partial pressure and the sensor 
reading.  You have the option of displaying the pressure reading on the LCD 
display (1) as described above in 7.10.  The display will now show the pressure 
reading from the internal sensor.  If you want to view different units select no. 5 
“Set Units” from the menu and press ENT three times to reach the pressure screen.  
Use the UP & DOWN arrows to select mbar, bar, psi, torr or kPa and press ENT.  
The display will now show the pressure in the selected units. 
 

7.12 Pressure Mode 

 

The user has the option of using the reading from the internal pressure sensor to 
automatically correct for changes in gas pressure and hence oxygen pressure.  A 
manual pressure correction value for ambient pressure conditions can also be 
entered to improve accuracy of the correction (factory setting is 1013 mbar).  To 
access this function scroll down to menu option 7 “Pressure Mode” and press 
ENT.  The desired mode can then be selected using the UP & DOWN arrows and 
pressing ENT to store and proceed.  The two modes available are: 
 

1. None:  If this mode is selected then there is no pressure correction 
performed on the oxygen reading.  The pressure and oxygen sensor act 
independently.  If the sensor is working in air (20.95%) and the pressure is 
doubled to 1000 mbar then the reading will also double to 41.9%.  This is 
the correct oxygen partial pressure in air at 2 bar since there is a simple 
linear relationship between pressure and concentration. 
 

2. Auto: This is the factory default setting.  If the Auto mode is selected then 
the Rapidox 1100 uses the reading from the internal pressure sensor to 
correct the oxygen partial pressure and maintain a concentration reading.  If 
the sensor is working in air (20.95%) and the pressure suddenly jumped to, 



Cambridge Sensotec Rapidox 1100ZR Oxygen Analyser Instruction Manual 
 

 

 

 
Version 3.7 16 Last printed 17/11/2011 10:46:00 
 

for example, 500 mbar above atmospheric, the oxygen reading would 
remain at 20.95% because the sensor has been corrected for the pressure 
change.  This allows users who are working with fluctuating input 
pressures to maintain a ‘meaningful’ reading of oxygen concentration that 
will only be affected by changes in gas composition and not gas pressure. 
 

Note that when this mode is activated the user will be asked to enter a value for 
the current ambient pressure to improve the accuracy of the correction.  The 
factory default is 1013mbar which is the average ambient pressure for the UK.  
The ambient pressure at your location will depend on altitude and prevailing 
weather conditions. 
 

7.13 Setting the Baud Rate 

 

If you are using the software for data logging you can chose the communications 
speed (Baud Rate) by scrolling down the menu to no. 8 “Baud Rate” and using the 
UP & DOWN arrows to select either 9600 or 57,600.  Press ENT button again to 
store and return to normal operation.  The default factory setting is 57,600.  
However if you are using an older PC you can decrease this to 9600 to improve the 
reliability of the software and data communications. 
 

7.14 RS232 / RS485 Port 

 

It is possible to factory set the data communications port to either RS232 or 
RS485.  Once configured at the factory it is not possible to change unless the unit 
is returned to Cambridge Sensotec Ltd. 
 
Data from the Rapidox is sent on demand to the 9-way 'D' type socket (8) on the 
rear panel and can be read using a simple terminal programme such as 
'HyperTerminal' in Windows, or with the user's own custom software.  
Alternatively a simple and convenient data logger programme is included with the 
supplied software and is described in section 9 below. 
 

7.14.1 RS232 Protocol 

 
Oxygen data can be read from the RS232 port at the back of the Rapidox.  The 
default RS232 configuration is 57600-8-N-1, as shown in this example for COM1: 
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Figure 6: Rapidox default COM properties box 

 
Alternatively, the baud rate can be reduced to 9600 via the “Set Baud Rate” menu 
item, using the front panel keypad on the Rapidox.  This setting is stored in 
EEPROM. 
 
Connection:  Connect to RS232 socket at the back of the Rapidox using a 9 way D-
type plug.  Signals are as follows: 
 

Rapidox D-type Socket:  PC/PLC: 
Pin# 2 = Data Out   Data In (RX) 
Pin# 3 = Data In   Data Out (TX) 
Pin# 5 = Common/Gnd -- Common/Gnd 
 

 

Figure 7: Rapidox RS232 pin configuration 

 
All other pins (1,4,6,7,8,9) = Don’t care 
 
Reading Data:  Data is read using command “D”.  Send the single character “D” to 
the Rapidox.  The Rapidox replies with one of the following responses.  All valid 
responses end with [CR] & [LF] (where [CR] = ASCII 13  and [LF] = ASCII 10).  
 
Response: !Initialising[CR][LF] 
Meaning: Rapidox is still initialising 
 
Response: !Sensor heating[CR][LF] 
Meaning: Rapidox is still heating sensor to operating temperature 
 

 
 
 
 
 

RS232 

5 4 3 2 1 

9 8 7 6 
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Response: !Sensor cooling[CR][LF] 
Meaning: Rapidox is still cooling sensor to operating temperature.  This can 

happen when switching from Normal to Helium operating mode. 
 
Response: !Cleaning sensor[CR][LF] 
Meaning: Rapidox has finished heating sensor and is cleaning the sensor for 5 

seconds 
 
Response: !User setup active 
Meaning: The configuration menu has been activated via the front panel 

keypad.  The menu will automatically time out 60 seconds after the 
last key was pressed, or press the keypad’s ESC key to return 
immediately to normal run mode. 

 
Response: !Possible sensor fault 
Meaning: The sensor has failed to reach operating temperature within 10 

minutes from power up.  This may be due to the age of the sensor, or 
because a high thermal conductivity gas is being used. 

 
Response: !No sensor or sensor fault[CR][LF] 
Meaning: Sensor is not connected, or there is a fault in the sensor 
 
Response: d2.959E+05,-1.426E+01,2.000E+00, ,23:19:40,14/01/00, 

M,,AL1&2[CR][LF] 
Meaning: “d” means data is being sent  
 “2.959E+05” is Oxygen reading in ppm 
  “,” = data separator 
 “-1.426E+01” is Oxygen sensor reading in mV 
 “,” = data separator 

“2.000E+00” is the internal pressure sensor reading in bar (gauge) 
 “,” = data separator 
  “23:19:40” is Rapidox time – ignore this 
 “,” = data separator 
 “14/01/00” is Rapidox date in DD/MM/YY format – ignore this 
 “,” = data separator 
 “M” is the current oxygen “range” setting 
 “,” = data separator 
 “,” = data separator 
 “AL1&2” means both alarm conditions 1 and 2 exist ** 
 [CR] = ASCII 13 (Carriage Return character) 
 [LF] = ASCII 10 (Line Feed character) 
 
** If no alarm conditions exist, this data is empty, so the response would look 
like:  
  
d2.959E+05,-1.426E+01,2.000E+00, 3.619E+01,23:19:40,14/01/00,M,,[CR][LF] 
 
Response: ? 
Meaning: “D” command was not recognised.  Try to send it again. 
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7.14.2 RS485 protocol 

 

Please contact Cambridge Sensotec for further information on this feature. 
 

7.15 Printing 

 

If you have purchased the printer option then you have the option to print out 
various data from the analyser straight on to thermal paper.  Simply connect the 
printer to the unit using the serial socket on the rear of the machine and make 
sure the printer is switched on (battery and mains versions are available).  To 
print the live values on the LCD at any time simply press the RIGHT arrow button 
on the front panel.  Each push of the button will print out the serial number 
followed by the data in a tabbed format followed by a blank line.  If the button is 
held down, the printer will keep printing data (but not the serial number). 
 
When the printer is first connected or turned on, a “start-up” message like the one 
displayed on the LCD when the Rapidox is switched on will be printed, and will 
look like this: 
 

Cambridge 

Sensotec Ltd 

Rapidox 1100ZR 

Oxygen Analyser 

S/N: 2100942 

FW v 01.03.03.01 

 

7.16 Load Defaults 

 

If you make a mistake programming the Rapidox it is possible to restore the 
machine back to its factory settings by loading the unique default configuration 
that is supplied on your software CD-ROM.  The default set-up can only be 
accessed using the software provided.  Please see section 9.22 for further details. 
 
Alternatively, you can reset to ‘generic’ factory defaults directly from the front 
panel keypad.  Press ENT to enter the user setup menu and select menu option 10 
“Load Defaults” and press ENT to proceed.  The next screen will say “Load 
Defaults ?” with the prompt to press and hold ENT for 2 seconds to confirm.  To 
complete this press the ENT button until the bar graph has completed and the 
screen says “Defaults Loaded”  This will give you all the basic settings that are 
factory set.  You will now need to re-calibrate the sensor and check all the settings 
are suitable.  
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8. Rapidox Software Instructions 
 

8.1 Software Installation 

 
It is possible to programme a range of variables to the Rapidox using an RS232 (or 
RS485 if configured) link with a PC running MS-Windows (all versions) and the 
supplied Rapidox software.  The software is installed automatically by inserting 
the Rapidox CD into the CD-ROM drive.  If auto-installation does not start then 
you can click the Windows START button and select RUN.  Type X:\setup.exe 
where X is the drive letter of your CD.  Alternatively access the CD from Windows 
Explorer or the ‘My Computer’ icon on your desktop, and double-click on the 
‘Setup.exe’ programme.  Follow the on-screen instructions to install the 
programme onto the hard drive.  Once installed, you can access the programme by 
clicking START - PROGRAMS – Rapidox Software. 
 
The software has been tested successfully on most language machines including 
Chinese, Korean & Japanese and all current versions of Windows operating 
system.  We do not recommend the use of Vista as connecting devices to this 
operating system can be problematical at best. 
 
Note that software is ‘regionally aware’ and will therefore accept and display data 
using the decimal separator that is set in the PC’s Regional Settings in the Control 
Panel.  For example, in the UK or US, you might enter the value 2.5 - in 
continental Europe this would normally be entered as 2,5 assuming the PC’s 
Regional Settings have been set up to use ‘,’ as the decimal separator. 
 

8.2 Getting Started 

 
Make sure that the Rapidox is connected to a free serial port on the rear of your 
computer.  These will nearly always be COM1 or COM2 but the software will scan 
through the ports until it finds the Rapidox.  The analyser must be switched on for 
this to succeed and while you are communicating with it.  On start up the 
software will locate the Rapidox and display the following page: 
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Figure 8: Rapidox configuration page.  Note the actual values used may differ from those shown 
above. 

 

The yellow status box at the bottom will display confirmation that the Rapidox 
was found and the result of the last action, or any error messages if there is a 
problem with communication.  If you experience problems check that your serial 
cable (supplied) is correctly fitted to a valid serial port.  Also check the status of 
your COM port settings in Device Manager accessed by clicking START – Settings 
- Control Panel. 
 

8.3 On-Screen Help 

 
You can access the on-screen help facility at any time by clicking on the help 
menu on the menu bar and select the ‘Help’ option or press F1. 
 

8.4 Configuration Page 

 
The configuration page is split into three, and you can switch between them by 
clicking on the tabs labelled “Config 1”, “Config 2” or “Alarm Config”.  Each page 
allows the user to reprogramme an array of variables used by the Rapidox.  Once 
written to the Rapidox, the new variables remain permanent until overwritten. 
 
To read the current configuration stored in your Rapidox select ‘Read Analyser 
Configuration’ from the ‘File’ menu, or click the ‘Read’ button on any of the 
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‘Config’ pages.  Note that the entries in the boxes on the RHS (under the ‘Write’ 
button) will turn red if the value is different to that just read and a red asterisk 
will appear next to the ‘Write’ button to warn you that a change has been made.  
The left-hand set of grey text fields (‘read fields’) will be updated with the current 
configuration data.  To save this information (e.g., if several people share the same 
instrument) click the long copy (‘>>’) button (between the ‘Read’ and ‘Write’ 
columns) on any of the ‘Config’ pages in order to transfer the data into the edit 
boxes, select ‘Save Configuration as’ from the ‘File’ menu and choose a filename.  
This data set can be subsequently reloaded at any time by selecting ‘Load 
Configuration File’ from the ‘File’ menu and then selecting the folder where the 
configuration files have been stored. 
 
If at any time you wish to restore the Rapidox to its factory default settings select 
‘Default Configuration’ from the ‘File’ menu to load these values.  The software 
will search for a unique ‘.rxc’ file which is loaded onto the PC during the software 
installation.  The filename is ‘XXXXXXX.rxc’ where ‘XXXXXXX’ is the unit’s 
serial number, which can be found on the rear of the machine.  The original copy 
of this file is also on the CD-ROM that came with the analyser.  Normally this file 
is automatically copied to the main Rapidox folder, but if the software cannot 
locate it then it will ask you for the serial number to help it search.  The ‘rxc’ file 
will be loaded into the ‘Write’ columns, and the software will then automatically 
perform a ‘Read’ to update the data in the ‘Read’ columns in order to highlight the 
differences between the current configuration (in the ‘Read’ columns) and the 
settings from the file (in the ‘Write’ columns).  If you wish to proceed with the 
reconfiguration simply click any of the three ‘Write’ buttons to reprogramme the 
Rapidox. 
 
The right-hand set of white editable text fields (‘write fields’) is used to enter new 
values to be programmed into the Rapidox.  The values in these fields can either 
be entered manually, or copied across from the ‘read fields’ by clicking the vertical 
‘Copy’ button, and then edited as required, however greyed boxes under the 
‘Write’ buttons are not editable as they contain calibration data; they can only be 
changed by copying data across from the ‘Read’ fields.  Note that when you click 
on the copy button all three ‘Config’ pages are updated at the same time and there 
is no need to repeat the action when you toggle to the other page.  Alternatively, 
you can load saved configuration data by selecting ‘Load Configuration’ from the 
‘File’ menu and selecting the required file.  In order to programme the analyser 
select ‘Write configuration to the analyser’ from the ‘File’ menu, or click the ‘Write’ 
button on any ‘Config’ page. 
 

8.5 Reconfiguring the Analyser 

 
The on-screen edit boxes contain variables that can be reprogrammed into the 
Rapidox in exactly the same manner as using the front panel keypad.  For a full 
description please refer to the relevant section in this manual. 
 
The user can choose whether to use ppm or percent notation to edit the text boxes, 
where appropriate, by selecting the ‘UNITS’ menu and clicking on ‘Percent’ or 
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‘ppm’.  To access a field, either click inside it or use the TAB key to scroll through 
them.  The field parameters are as follows: 

8.5.1 Config 1 Screen 

 
1) Oxygen Range:  Not available for the Rapidox 1100ZR 

 
2) Oxygen Units & Format: See Section 7.9 for a full description.  Use the 

drop down box to select PPM EXPONENTIAL, PPM MIXED, AUTO%/PPM 
or PRESSURE.  The default setting is AUTO%/PPM. 
 

3) Temperature Units/Enable: Not available for the Rapidox 1100ZR 
 
4) Pressure Units: See sections 7.9 for a full description.  Use the drop down 

menu to select MBAR, TORR or KPa as the unit for pressure measurement.  
The default setting is MBAR. 
 

5) Pressure Correction Mode: See section 7.12 for a full description.  Use the 
drop down menu to select NONE, AUTOMATIC or MANUAL.  The default 
setting is NONE. 
 

6) Operating Mode:  Not available for the Rapidox 1100ZR 
 

7) Auxiliary Output Parameter: Not available for the Rapidox 1100ZR 
 

8) LCD Refresh interval:  Use the drop down menu to select a refresh rate for 
the LCD (min 0.1, max 1.5 sec).  The default is 0.3 seconds. 
 

9) LCD Second Line Option:  See section 7.10 for a full description.  Use the 
drop down menu to select PRESSURE or NONE. 
  

10) Pump Flow Rate: See section 7.3 for a full description.  Use the drop down 
menu to select a pump flow value from 10-100% or OFF. 
 

11) Password option: See section 7.4 for a full description.  The password is 
factory disabled and set to 0000.  Use the drop down menu to enable or 
disable the password feature and the password box **** can be used to 
enter a new password.  Note that you will be prompted to enter the original 
password to make changes to the password or its status. 
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8.5.2 Config 2 Screen 

 

 

Figure 9: Configuration 2 page.  Note the actual values used may differ from those shown above. 
 

12) Calibration Gas 1, 2 & 3: These boxes are greyed out in this version and 
the data is for information purposes only.  If you want to change the current 
calibration gas then follow the procedure given in section 8.7. 
 

13) Calibration Constant A B & C:  These boxes contain the calibration 
constants that the Rapidox calculates automatically when you perform a 
calibration.  You will see that they change each time you perform a new 
calibration.  Generally the air value should be approximately -10mV and a 
low ppm value (e.g. 10ppm) would be approximately 180mV 
 

14) O2 Analogue Output (0V/4mA & 10V/20mA):  Use these two boxes to set 
the High and Low oxygen values for the analogue outputs (6) on the rear 
panel.  For example if you want 4mA to represent 1% and 20mA to 
represent 21% then enter these two values into the appropriate boxes.  The 
value can be entered either in % or ppm depending on the units selected.  
The default is %.  The default values are 25% for the high setting and 
0.001% for the low setting. 
 

15) Auxiliary Analogue Output (0V/4mA & 10V/20mA):  Use these two boxes 
to set the High and Low auxiliary (pressure sensor) values for the analogue 
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outputs (6) on the rear panel.  For example if you want 0V/4mA to represent 
0mbar and 10V/20mA to represent 100mbar then enter these two values 
into the appropriate boxes.  The units are automatically determined by the 
settings made in 4). 
 

16) Absolute Ambient Pressure: Use this box if you want to enter the current 
ambient pressure (in mbar).  This value is used in the automatic pressure 
correction function only and provides enhanced accuracy in the correction.  
The default is 1013mbar which is the average ambient pressure in the UK. 
 

8.5.3 Alarm Config Screen 

 

 

Figure 10: Alarm configuration screen.  Note the actual values used may differ from those shown 
above. 

17) Alarm Source: Use the drop down box to assign a detector to the alarm.  If 
you want the alarm to be based on oxygen readings select oxygen from the 
drop down list.  The choices are: oxygen, pressure or temperature. 
 

18) Alarm Outputs:  This option enables or disables the alarms on the rear 
panel (labelled Alarm High +/- and Alarm Low +/-).  Make sure these are 
enabled if you wish to use the signals from the alarm circuit. 
 

19) Audible Alarm:  This option enables or disables the audible buzzer fitted to 
the Rapidox internally.  When an alarm condition occurs the buzzer will 
emit a continuous noise to alert the operator. 
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20) Visible Alarm:  This option enables or disables the visual warning on the 

front LCD.  When enabled and an alarm condition occurs the message 
“AL1” or “AL2” will flash in the lower right hand corner. 
 

21) Rising or falling Alarm: This option allows the alarm to be set as a rising or 
falling type.  If the alarm is rising then the reading must rise above the set-
point for the alarm to be activated.  If the alarm is falling then the reading 
must fall below the set-point for the alarm to activate. 
 

22) Contacts N/O or N/C:  This option allows the user to programme how the 
relay contacts are set on the rear panel.  Normally Open means that the 
contacts are open circuit when an alarm is not activated and Normally 
Closed means that the contacts are closed when the alarm is not activated. 
 

23) Alarm Setpoints: Use this box to programme the set-point value at which 
you want the alarm to activate.  The units are in %, ppm or mbar depending 
on which sensor you have assigned to the alarm. 

 
Once you have finished editing the parameters, select ‘Write Configuration to 
Analyser’ from the file menu and the new data set will be written to the Rapidox.  
The Rapidox is reprogrammed using the new configuration.  The software then 
reads the new settings back from the Rapidox and displays them in the boxes on 
the left-hand side confirming that the configuration was successful.  When you 
have finished programming the analyser for new calibration gases you must 
recalibrate the instrument to benefit from the changes. 
 

8.6 On-Screen LCD 

 

It is possible to display an LCD emulator on the desktop of your PC.  This 
reproduces exactly the display on the Rapidox unit and is convenient if you are 
some distance away from the machine.  To activate the LCD select the utilities 
menu and select the LCD on option.  This will display a small window showing 
the LCD that can be positioned independently anywhere on the desktop. 
 

 

Figure 11: On-screen LCD 

 

The blue LED indicator will flash to show that the display is updating. 
 

8.7 Remote Calibrating and Cleaning 

 

With the on-screen LCD display active it is possible to remotely calibrate the 
analyser and clean the sensor.  Click on the down arrow icon in the bottom right-
hand corner of the LCD display to expand the window: 
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Figure 12: Remote calibration and clean function 

 

Use the four buttons to calibrate or clean the sensor directly from the PC.  Before 
calibrating the analyser with gas, make sure that you know the exact O2 
concentration in your gas bottle AND you have a calibration certificate from the 
gas supplier confirming the concentration.  You can calibrate the analyser in any 
order but remember that the gas value for O2 High must be greater than the gas 
value for O2 Middle, which must be greater than the gas value for O2 Low.  Allow 
sufficient time for the calibration gas to pass over the sensor and let the reading on 
the LCD stabilise.  This is extremely important to perform a successful and 
accurate calibration. 
 
The software uses the three calibration gas values already stored in the Rapidox as 
a starting point.  These are typically High = 20.95%, Middle = 0.1% and Low = 
0.001% as set in the factory but may be different if the user has recalibrated with 
other gas values in the past.  Either way you are given an option to change the cal 
gas value before proceeding to the actual calibration. 
 
Assuming you are using fresh air (20.95%) to calibrate O2 High then simply click 
on the button labelled “Calibrate High O2” to see the following: 
 

 

Figure 13: Calibration Gas Confirmation Screen. 

If the current stored value is correct and matches your cal gas value then simply 
click “Yes” to proceed.  If you are using a different value to the one you see on the 
screen then click “No” to change it as shown below: 
 

 

Figure 14: Calibration Gas Update Screen. 
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Enter your new value in the units as instructed and click “OK” to proceed.  This 
value will then be stored until you want to change it again.  You will now see the 
following screen: 
 

 

Figure 15: Calibration Confirmation Screen. 

 

This is your final chance to change your mind before committing to a calibration.  
Check carefully that the gas value on the screen actually matches the value of your 
calibration gas before clicking on “Yes” to complete the calibration.  At this point 
you should observe that the LCD display will reset itself to the correct calibration.  
You can now proceed with the rest of the calibration process by selecting the 
Middle and Low gases in the same manner. 
 

8.8 Calibration Error Messages 

 
During the calibration process described in 8.7 above it is possible to receive 
screen error messages as described here. 
 

1) Bad Sensor Reading:  The Rapidox software makes a prediction of the 
expected sensor mV for each calibration gas value entered.  If the mV signal 
coming from the sensor is out of the expected range the following message 
is displayed: 
 

 
 
This normally indicates one of two things: that you are using the wrong cal 
gas value compared with the actual gas flowing over the sensor OR the 
sensor is getting old and can no longer output the expected signal required 
for a healthy calibration. 
 

2) Bad Pressure Reading:  The Rapidox software checks to see what the gas 
pressure is before allowing the calibration to continue.  If the pressure is 
outside the range -25mbar to +25mbar (gauge) then the following message 
is displayed: 
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This normally indicates that you are allowing gas from a cylinder set at too 
high pressure to enter the analyser.  Try displaying the pressure reading on 
the second line of the LCD and adjusting the gas regulator to trim it close to 
0 mbar.  If you are using a standard gas regulator then try switching off the 
sample pump on the rear of the analyser OR better still use a demand flow 
regulator and allow the gas to enter the analyser from the draw of the 
pump. 

 
Note that the above are only advisories and you can proceed with the calibration if 
you believe everything is checked and correct. 
 

8.9 Software Utilities 

 

The utilities menu is located on the main file menu as shown below: 
 

 

Figure 16:  Software Utilities Menu 

8.9.1 Setting Analyser Date and Time 

 
The current date and time of your PC are displayed on the configuration screen 
and can be loaded into the Rapidox by selecting the Utilities menu and clicking 
the ‘Set date and time’ option.  This information is used in the RS232 data string 
for data logging purposes.  Make sure that your PC clock is set correctly before 
using this function, as you cannot edit the date and time shown by the Rapidox 
software.  The date and time formats displayed are those set in the PC’s Regional 
Settings. 
 

8.9.2 Check for Updates 

 

This function will check online and advise you if any software updates are 
available for your machine.  This function is not automatic.  To update the 
software you need to visit www.cambridge-sensotec.co.uk and select the support 
page where a list of downloads are provided. 

http://www.cambridge-sensotec.co.uk/
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8.9.3 Image Grabber 
 

This is a simple function to allow the user to copy the software screens into the 
Windows clipboard.  This is useful for diagnosing problems; allowing a quick and 
simple way of sending the Sensotec technicians actual screen shots of the 
software.  To recover the images simply press CTL+V to paste. 
 

9. Rapidox Data-Logging Software 
 

9.1 Introduction 

 
The Rapidox software includes a full data logging facility.  Data can be saved to a 
file automatically at regular intervals and the format is compatible with modern 
spreadsheet programmes such as MS-Excel.  A live-time graphing facility is also 
included which has many powerful features.  Note that the data logging facility 
will only function if the analyser is in NORMAL run mode. 
 

9.2 Setting up the Data Logger 

 
Click on the tab labelled ‘Data Acquisition’ to display the following page: 
 

 

Figure 17: Data Logging page 
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During logging, data from the analyser is shown in the central area of this page.  
The data is displayed in the following columns: time (in seconds), the raw signal 
from the sensor (in mV), the oxygen value (in ppm scientific notation), pressure in 
mbar, the time (in regional format), the date (in regional format), and status 
(displays the range setting or the word ALARM if the alarm is activated). 
 
To start data logging select the frequency of measurement by entering a time and 
selecting a unit from the drop down list.  For example if you wish to log data once 
every minute type 1 in the box and select ‘Mins’ from the drop down menu. 
 
You can open the NOTES window at any time by selecting NOTES from the ‘Data 
Logger’ drop down menu.  A small text box appears in which you can type a text 
message.  This note is then saved as a header in the data file set and can be viewed 
along with the data. 
 
You can either choose to have data logged continuously until ‘Stop’ is selected 
from the Data Logger menu, or you can choose to set a time limit for data logging 
by checking the box labelled ‘Time Limit’, setting the duration in the ‘Run For’ box 
and selecting units with the drop down list.  For example if you wish to log data 
for thirty minutes type ‘30’ in the box and select ‘Mins’ from the drop down list. 
 

9.3 Running the Data Logger 

 
If you wish to save the data into a file for later use, check the ‘Save to File’ box 
before selecting ‘Run’ from the Data Logger menu.  You will be prompted for a file 
name and location before data logging commences.  The file and path information 
will appear in the box at the top of the page labelled ‘Data File Name’.  If you 
forget to select file saving before starting a run, you will nevertheless be prompted 
at the end as to whether you wish to save the run data. 
 
The blue progress bar displays the state of completion of the run, and the blue box 
to the right of it the same information as a percentage.  You can stop the run at 
any time by selecting ‘Stop’ from the Data Logger menu.  The yellow Status bar at 
the bottom of the page gives information about the data logging operation. 
 
Once data logging is complete you may open the text format data file using any 
compatible spreadsheet programme such as MS Excel, and use the data to 
generate plots and reports. 
 
You can pause the data logger at any time by selecting ‘data logger’ and ‘pause’.  
Repeat to continue logging from where you left off, noting that the clock keeps 
ticking during the pause period. 
 

9.4 Auto Date Stamped Files 

 

If you are planning to run the data logger for extended periods of time then you 
should consider checking the ‘Auto date stamped file’ option.  This feature will 
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save the data at midnight for the previous twenty four hours and so on until the 
data-logging is complete OR the user interrupts.  The data file is stored with a date 
suffix in brackets in yy-mm-dd format. 
 
This feature ensures that data is saved periodically in sensible sized files.  This 
will prevent the computer from crashing and will also ensure that the data is small 
enough to fit into an Excel spreadsheet 
 
As an example, the user wishes to run the data-logger for seven days recording 
every minute starting at lunchtime on 12th November 2005.  He starts the data 
logger with the auto-date stamp function enabled.  When prompted he gives the 
filename as test1.  In this situation the data logger will run from lunchtime to 
midnight and then save the first file as test1 (2005-11-12).  The data logger then 
clears and continues for another twenty four hours until midnight the following 
day.  The data is then stored as test1 (2005-11-13).  This will continue for seven 
days when the data-logger will finish. 
 
After this the user will have a sequence of files: 
 
test1 (2005-11-12).txt 
test1 (2005-11-13).txt 
test1 (2005-11-14).txt 
 
And so on.  Combined together they represent all the data over the last seven days.  
Note that the Rapidox uses the computer clock and date to perform this action, so 
make sure that they are correct before starting a run. 
 
To view the data in its entirety the user would need to load each file in turn back 
into Excel to combine. 
 

9.5 Live Time Graphing Screen 

 

The Rapidox data-logging package includes a live-time graphing facility that 
allows you to monitor the progress of your data in a graphical format (see Figure 
18).  To access the graph check the box labelled ‘Show Graph’.  The graph will 
appear in a new window, and can be accessed at any time without disturbing a 
run that is already in progress.  You can select  ‘Run’ and ‘Stop’ from the Data 
Logger menu to begin and end data logging, and the window can be minimised to 
(and restored from) the task bar while logging data.   
 
To close the window and return to the main data-logging page select ‘Close Plot’ 
from the File menu or click on the close window button. 
 
The features of the graph window are described below: 
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Figure 18:  Live-time graphing screen 

 

9.6 Main Graph Window 

 

The graph is an XY plot, with time plotted on the X-axis, oxygen plotted on the 
primary Y-axis (Y1) and pressure plotted on the secondary Y-axis (Y2).  The X-axis 
and the two Y-axes auto-scale during data logging so that all data points are shown 
on the graph. 
 

9.7 Plot Colours 

 

The default colours used on the graph are set to blue for oxygen and red for 
pressure.  To change the colours double-click on the coloured axis label at the top 
of each axis.  A colour palette window will appear (see Figure 19) and a new 
colour can either be chosen from a colour box, or for more variety, by clicking the 
‘Define Custom Colors >>’ button.  Click on ‘OK’ to select the new colour or 
‘Cancel’ to return to the graph without change. 
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Figure 19: Plot colour palette menu accessed by double-clicking on the axes titles. 

 

9.8 Graph Titles and Labels 

 

If you want to change the text of the graph axis labels, place the mouse pointer 
over the text and do a single left click to enter edit mode.  The text can then be 
modified.  Similarly, to change the title of the graph, place the mouse pointer over 
the title and click once to edit.  If you choose not to enter a title the graph will 
display the path and filename of the run as the new title once the run has 
finished.  Note that these changes are only temporary and will be overwritten by 
the defaults if a new run is started or the graph window is closed and reopened.  
They are provided so that the plot may be printed with alternative labels. 
 

9.9 Plot Co-ordinates 

 

The box labelled ‘Plot co-ordinates’ to the upper left of the graph window displays 
the actual plot co-ordinate value at the mouse pointer.  This can be used to get a 
quick oxygen value from the graph.  Simply place the mouse pointer at a place of 
interest and read the corresponding X1 and Y1 values in the box. 
 

9.10 Last data point 

 

During data acquisition, the box labelled ‘Last data point’ will appear at the upper 
middle of the graph window.  It displays the last data values read from the 
analyser. 
 

9.11 Using the Cursor 

 

Clicking and holding the left mouse button with the pointer over the ‘C’ at the top 
of the plot area activates the cursor, which appears as a vertical dashed line on the 
plot.  While keeping the mouse button pressed, you can now move the pointer 
anywhere in the plot area or on the ‘C’ in order to move the cursor.  The box 
labelled ‘Cursor’ to the upper right of the graph window will display actual values 
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for oxygen, temperature, time and the data point number (n) at or immediately to 
the left of the cursor position.  The cursor can be used to investigate actual data 
values at specific points of interest on the graph. 
 

9.12 Zooming 

 
You can zoom in to any part of the oxygen plot by simply placing the mouse 
pointer on the new graph start position and then clicking and dragging a new box 
to re-size the graph.  The label on the box to the upper left of the graph window 
will change to ‘Zoom box co-ordinates’, and an extra set of co-ordinates, labelled 
X2 and Y2, will appear, showing the co-ordinates in X and Y units of the second 
corner of the zoom rectangle as you drag the mouse pointer.  The plot will zoom 
and auto-scale when you release the mouse button.  This can be repeated if you 
wish to zoom in even further.  To zoom back to the original size select ‘Zoom Full’ 
from the View menu. 
 
Note that although you can use the zoom facility during a live run, the graph will 
auto-scale to full size with each new data point. 
 

9.13 Y-Axis Graph Units 

 
You can toggle the Y1 oxygen units at any time from percent to ppm and vice 
versa.  Select ‘O2 Units’ from the View menu and chose either percent or ppm.  
The current selection is then displayed in the top right box labelled ‘O2 Axis’. 
 

9.14 Oxygen Scale 

 
You can display the Y1 oxygen axis in linear or logarithmic format at any time by 
selecting ‘O2 Scale’ from the view menu. The current selection is then displayed in 
the top right box labelled ‘O2 Axis’.  Note that the zoom function is disabled when 
you are viewing on a log scale. 
 

9.15 Second Y Axis 

 

The secondary Y axis located on the right hand side of the graph can be used to 
display the pressure taken from the internal pressure sensor.  The axis is linear 
and auto-scaling.  To select the mode of the secondary axis select ‘view’ and then 
‘second axis display’.  Choose from ‘none’ or ‘pressure’. 
 

9.16 Loading an Old Run 

 
A previously logged data file can be loaded and viewed by selecting ‘Open Data 
File’ from the File menu and selecting the appropriate TXT or CSV file.  A 
progress bar is displayed while the data is being imported.  Note that very large 
data files may take several seconds to load.  The data is re-graphed and you can 
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zoom, label axes, change colours etc., before printing the graph. 
 

9.17 Printing Graphs 

 
You can print the graph at any time by selecting ‘Print Plot’ from the File menu.  
This will bring up the printer dialogue box for your specific printer where you can 
chose various printing options.  Make sure that the printer page is set to landscape 
to obtain a full size print out. 
 

9.18 Data Logging in the Background 

 
It is possible to begin data logging and then minimise the windows to continue 
working with another application.  To minimise the graph simply click on the 
minimise button on the blue title bar at the top of the window.  You can then use 
the ALT + TAB keys to take you to other programmes already running.  To return 
to the graph simply maximise from the start menu bar or press ALT + TAB again.  
If the graph does not redraw immediately select ‘Zoom Full’ from the View menu 
to redraw. 
 

9.19 Pausing the Data Logging 

 

You can pause the data-logging at any time during the run by selecting the ‘data 
logger’ menu and selecting ‘pause’.  Repeat the action to continue, noting that the 
live graph will draw a straight line between the paused points to keep continuity 
of the axes.  The clock keeps ticking during the pause period. 
 
If you decide to access the menu of the Rapidox using the front keypad during 
data logging, then the software will pause automatically.  A message appears on 
the screen informing the user that the unit is being accessed from the keypad.  
Once the menu has been exited, the software will continue data logging from 
where it left off. 
 

9.20 Changing the Data Logging Parameters Mid-run 

 

Once the data logging has begun you may change the sample interval time by 
pausing the data logger and then entering a new value for the time interval.  The 
data logger can then be resumed with the new values in place.  Note that you can 
not change units (e.g. seconds to hours) once logging has started.  If you originally 
selected seconds then you may change the current value to a new value between 1 
and 3600 seconds, if you originally selected minutes then you may change 
between 0.02 and 360 and if you selected hours you may change between 0.01 and 
6 hours.  Note it is not possible to modify he original total length of time that the 
data logging will run for once a run has commenced. 
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9.21 Working with Spreadsheets 

 
The data-logger saves data files in a standard comma separated ASCII text format 
which can be readily imported into spreadsheet programmes such as MS Excel, in 
order to produce plots and reports as desired.  For specific information on how to 
import text files into your spreadsheet programme please refer to the help guide 
supplied with the programme. 
 
Data is saved in comma separated value format, with a ‘.txt’ file extension as the 
initial programme default.  However, when entering the file name, you can instead 
select a ‘.csv’ extension: the programme will register the last used file extension as 
the new default.  The ‘.csv’ extension is recognised by MS Excel, so that opening 
the file will automatically run MS Excel, and this may be of benefit if your 
regional decimal separator is period ‘.’ rather than comma ‘,’.  However, if your 
decimal separator is comma, you should continue to use the ‘.txt’ extension and 
open the file explicitly from within your spreadsheet programme, defining the 
field delimiter as ‘comma’ where appropriate. 
 

9.22 Disaster Recovery 

 
To prevent catastrophic loss of important data during a computer crash or power 
failure, the data is automatically saved point by point in a temporary file called 
‘Rapidox temporary data file.txt’.  This file is located in the same directory as the 
main Rapidox programme itself and can be renamed or copied to recover data that 
would otherwise be lost.  Note that this file is overwritten each time ‘Run’ is 
selected from the Data Logger menu so make sure all data is recovered 
successfully before starting another run. 
 
Note that during a run using the ‘auto date stamped’ feature the temporary data 
file is wiped clean as soon as the previous data set has been saved successfully.  In 
the case of a crash the temporary data file should be used to recover the last day’s 
worth of data that was not saved to the hard disc. 
 

9.23 Diagnostics 

 

The Rapidox software includes a diagnostics page that is accessed from the tab 
labelled ‘Diagnostics’.  This screen will display various values and settings that are 
operating inside your machine.  There is no editing possible on this page – it is 
purely for information and to enable technical support help you should you 
experience difficulties with your machine.  You may be asked to record values 
from this page if trouble shooting is required. 
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Figure 20: Rapidox Diagnostics Page 

 

1. Analogue:  The live analogue values displayed in this pane are voltage 
measurements coming directly from the computer chip inside the analyser.  
They are for information purposes only but are a useful diagnostics tool for 
Sensotec staff, as unusual values can indicate a particular fault.  To help 
Sensotec diagnose a fault please capture this window as shown above using 
the screen capture function described in section 8.9 above and e-mail it to 
support@cambridge-sensotec.co.uk  
 

2. Sensor State:  These boxes should all indicate “OK” on a healthy analyser.  
Note that the Rapidox 1100ZR does not have a temperature sensor fitted so 
all references to temperature on this screen are not relevant.  The possible 
messages are “OK” “High” “Low” or “Fault”.  The High and Low messages 
indicate that the sensor is out off normal range.  The fault message will only 
display if the sensor is disconnected or has failed in some way. 
 

3. Digital:  The digital signals coming directly from the computer chip inside 
the analyser can be monitored here.  To test the keypad is working correctly 
try pushing the buttons and watching the panel.  A correctly functioning 
key will turn the box red on the screen and the digital value for that 
particular key will show in the data box.  If the analyser has an external 
thermocouple correctly fitted (2100 and 3100 series only) then this will 
display a signal in the “Temperature Sensor” box. 
 

4. Log Diagnostic Data:  Checking this box will allow the software to log the 

mailto:support@cambridge-sensotec.co.uk
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diagnostic data which can then be e-mailed to Sensotec for analysis.  Do not 
switch to a different tab while logging diagnostic data – the data is only 
logged while the “Diagnostics” tab is still selected.  The software will log 
diagnostic to a file named “Rapidox diagnostics file 210xxxx.txt” (where 
“xxxx” is the serial number of the analyser) in the folder shown in the 
yellow “Status” box at the bottom of the screen.  Data is logged every 6 
seconds, so the software should be left to run for at least 1 minute to gather 
a few data points.  In order to stop logging, simply uncheck the “Log 
Diagnostic Data” tick box.  Note that diagnostic data is always saved to the 
same file, and will automatically overwrite any existing file without 
prompting the user, so if you want to save existing data you must either 
rename it or copy (or move) it to a different folder, before checking the “Log 
Diagnostic Data” tick box again. If you are logging diagnostic data during 
the analyser’s warm up period, the “Acquisition data:” box will display the 
current sensor heating message, and will only display acquisition data once 
the oxygen sensor has reached its operating temperature. 
 
Once completed please e-mail this file to support@cambridge-
sensotec.co.uk for analysis. 

 

10. Troubleshooting 
 
Q: The Rapidox says 'sensor heating' but won't begin measuring. 
A: What kind of gas are you running over the sensor?  Does it contain 

hydrogen or helium?  If so then the heater may be struggling to heat the 
sensor with such cooling gas present.  Does the problem go away if room air 
is allowed into the analyser?  Contact Cambridge Sensotec for advice.  If the 
message continues for around eight minutes then the analyser will give up 
and  indicate that the internal heater has failed and the sensor needs 
replacing. 

 
Q: The Rapidox won't power up at all. 
A: There are fuses located on the power socket on both live and neutral lines.  

These are standard 20mm (1A for 240V versions, 2A for 110V) fuses 
available from a supplier such as RS Components. 

 
Q: The Rapidox gives strange readings that are way off the expected values. 
A: Check to make sure which calibration gases are selected.  Are they the same 

as the actual gases you used to perform the calibration?  If not you must 
recalibrate the analyser or re-load the factory defaults to get you going 
again.  

 
Q: The sensor does not read 20.9 - 21.0% in air (actual value is 20.95%). 
A: If the room air is very humid, it will slightly affect the observed 

measurement or the sensor may have drifted slightly because of natural 
ageing.  If you are using air as a calibration point then simply do a quick re-
calibration in the air to compensate for this. 

 

mailto:support@cambridge-sensotec.co.uk
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Q: I messed up the calibration procedure and the analyser is not working 
properly. 

A: Return the box to the factory defaults using the keypad or communications 
software, by selecting ‘Default Configuration’ followed by ‘Write 
Configuration to Analyser’ from the File menu.  Now try re-calibrating the 
Rapidox. 

 
Q: The software will not talk to the Rapidox. 
A: Make sure that you are using the correct cable, as supplied (pin 2 to pin 2 

etc).  A crossed RS232 cable (pin 2 to pin 3 etc.,) will not work.  Make sure 
that your COM ports are recognised by your computer.  Check in your 
Windows device manager to see if there are any conflicts.  If you have an 
internal modem fixed to your PC you may experience difficulties using this 
software.  Contact Cambridge Sensotec for further advice. 

 
Q: I selected ‘Write to the Analyser’ and now the Rapidox is way off 

calibration. 
A: Only select ‘Write to the Analyser’ once all the values are correctly entered 

in the boxes on the right.  The best procedure is to ‘Read Analyser 
Configuration’ and then press ‘Copy’ so the values in the boxes are the same 
as those stored in the Rapidox memory.  You can then edit these values and 
then select ‘Write to the Analyser’ when finished. 

 
Q: How do I get back to the factory calibration for my instrument. 
A:  Select ‘Load Configuration File’ from the File menu and look for the rxc file 

on your CD.  Select this file and then select ‘Write to the Analyser’.  This 
will load the factory calibration back into the Rapidox.  Alternatively you 
can load a standard default configuration any time using the ‘Load Default’ 
option on the File menu.  This configuration will not be perfect for your 
analyser but will be good enough to get you started again. 

 

10.1 Warranty 

 
The Rapidox analyser has been carefully tested and inspected before shipment 
and is guaranteed to be free from defective materials and workmanship for a 
period of twelve months from date of purchase.  The sensor head is replaceable 
and has a life expectancy in excess of 17,500 hours.  However, if the analysis gas 
contains corrosive gases or large quantities of particulates, sensor life may be 
shortened.  In the case of the latter, it is normally possible to insert a filter prior to 
the sensor head to remove the particulate material. 
 

10.2 Conditions of Warranty: 

 
1) This warranty is in addition to and does not affect any statutory rights of 
consumer purchasers.  This warranty is valid worldwide on a “back to base basis”. 
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2) This warranty covers breakdowns due to design or manufacturing faults; it does 
not apply to damage, however caused, wear and tear, neglect, unauthorised 
adjustment or repair, or any items of limited natural life. 
 
3) In the event of failure, please take the following action: 
 

a] Refer to the “Troubleshooting” section of your instruction manual to 
identify and possibly correct the problem. 
 
b] If the fault cannot be resolved, please contact the Cambridge Sensotec 
service and repair centre at the address given on the cover of the manual. 

 
4) The warranty period applicable shall be 12 months from the date of delivery 
provided that: 
 

a] Notice in writing of the defects complained of shall be given to Cambridge 
Sensotec (The Seller) upon their appearance, and 
 
b] such defects shall be found to have arisen from the Seller's faulty design, 
workmanship or materials, and 
  
c] The defective goods shall be returned to the Seller's premises at the 
Purchaser's expense if so requested by the Seller. 
 
d] Any repaired or replaced goods shall be redelivered by the Seller free of 
charge to the original point of delivery but otherwise in accordance with and 
subject to these Conditions of Sale. 

 
e] Alternatively the Seller shall be entitled at its absolute discretion to refund the 
price of the defective goods in the event that such price shall already have been 
paid by the Purchaser to the Seller, or, if such price has not been so paid, to 
relieve the Purchaser of all obligation to pay the same by the issue of a credit note 
in favour of the Purchaser in the amount of such price. 
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Cambridge Sensotec Ltd. 
Unit 29 Stephenson Road 
St Ives 
Cambs 
PE27 3WJ 
ENGLAND 

 

Tel. +44 1480 462142 
Fax. +44 1480 466032 

www.cambridge-sensotec.co.uk 
sales@cambridge-sensotec.co.uk  

VAT no. GB 745 939975 
Registered in England No. 4035592 

 

 

Rapidox CERTIFICATE of CALIBRATION 
 

 
Date:  ………………………. 
 
 
Rapidox Serial number:   ………………………………………. 

 

Calibration  Constant A   ………………………………………. 

 

Calibration Constant B   ………………………………………. 

 

Calibration Constant C   ………………………………………. 

 

Calibration Gas 1    ………………………………………. 

 

Calibration Gas 2    ………………………………………. 

 

Calibration Gas 3    ………………………………………. 

  

Configuration Filename   ………………………………………. 

 

 
 
Calibrated by:    ………………………………………. 
 
 

Signed: ……………………………………….. 
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®ENT1-Calibrate
(prompts 1)

2.095E+05ppm
(prompts 3)

 Enter for two seconds to calibrate Displays message for 1.5 seconds

Displays message for 1.5 seconds

 Back to Measurements : Changes Applied

 Enter for two seconds to calibrate

APPENDIX 1: MENU FLOWCHART FOR RAPIDOX 1100Z
2.095E+05ppm    O2
  0.0mbar

ESC

 Enter for two seconds to calibrate

Calib: O2 High
(prompts 2)

®ENT

®
ESC

Bargraph for five seconds

Continues on page 2 ®

 Back to Menu List : Changes Applied

Calib: O2 Middle
(prompts 2)

Calib: O2 Low
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ENT

®ENT

®ENT

1.013E+03ppm
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1.000E+01ppm
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........
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........

9.120E+00ppm    O2
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®ENT
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2-Clean Sensor
(prompts 1)

Clean Sensor?
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Cleaning Sensor
..........

ENT®

ESC

®

®

®

®

®
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®

® ®

Edit O2 High

Edit O2 Medium

Edit O2 Low

Cleaning Sensor
Sensor cleaned

®

Displays message for 1.5 seconds

ESC - Back to Menu List. No changes
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3-Set Alarms
(Prompts 1)

Set: Alarm 1
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(Options: O2, Press)

Outputs: On
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(Options: On, Off)
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(Prompts 6)
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(Prompts 6)
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(Prompts 6)
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1.000E+01
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®
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ESC
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Continues on page 3

Displays message for 1.5 seconds

 (Options: bar, psi, mbar, kPa, torr)

 Back to Menu List : Changes Applied

®®

Displays message for 1.5 seconds

 (Options: Pressure, None)

 Change the value 0.1 - 1.5 s

ESC

4-Set Outputs
(prompts 1)

5-Set Units
(prompts 1)

6-Display Setup
(prompts 1)

O2 out: lin(ppm)
(prompts 6)

 (Options: lin(ppm), raw mV, log(ppm))

Edit Value

1.000E+01  = 0V
(prompts 3)

2.500E+05  = 10V
(prompts 3)

Edit O2(ppm)
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(prompts 3)
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(prompts 3)

1.250E+03  = 10V
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Edit Value

Edit O2(ppm)
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®
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 (Options: Auto %, Pressure, N2 Bal %,
Exp ppm, Auto ppm)
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Pressure: bar
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Line 2 Options
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Refresh Interval
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L2:Pressure
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Interval: 0.3 s
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L2: Pressure
Line 2 set
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LCD refresh set
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Edit Ambient pressure

Mode: None
(prompts 5)

ENT

Mode: Auto
(prompts 3)

Mode: None
Mode configured

1.000E+03mbar
(prompts 3)

ENT

1.013E+03mbar
Pressure set

ENT ®

Displays message for 1.5 seconds
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 (Options: 9600, 57600) Displays message for 1.5 seconds

® Baud rate: 57600
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Baud rate: 57600
Baud rate set

8-Set Baud Rate
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9-Set Pump Flow
(prompts 1)

Pump Flow: 90%
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Pump Flow: 100%
Pump flow set

Displays message for 1.5 seconds

ENTENT ®

 (Use UP & DOWN arrows to select pump speed)
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Wraps around to Page 1

Enter password - default is 0000 (Options: Enable, Disable, Change)

Edit password

 Enable or Disable selected

®
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­
ESC

11 - Password Menu
(Prompts 1)

Password: 0***
(prompts 3)

Password: Enable
(prompts 2)

Password: 6234
(prompts 3)

Password: Enable
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 Back to Menu List : Changes Applied
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Continued from page 2

Prompts 1: Prompts 2: Prompts 3: Prompts 4: Prompts 6:

ENT = OK
ESC = Back

Prompts 5:

 = Change
ENT = Next
ESC = Back

 = Change
ENT = OK
ESC = Back

 = Change
® = Select Char.
ENT = OK
ESC = Back

 = Scroll Menu
ENT = Next
ESC = Back

 = Scroll Menu
ENT = Next
ESC = Exit

 Back to Measurements. ESC - Back to Menu List. No changes
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Load Defaults?
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ESC
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